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Revision Record

This Revision Record provides a concise publication history of this manual. It lists the
manual revision levels, release dates, and reasons for the revisions.

The following revision history lists all revisions of this publication and their effective
dates. The publication part number is included in the Revision Level column, with the
last entry denoting the latest revision. This publication supports StorageWorks RAID
Array 200 Subsystems in the Windows NT operating system environment.

Revision Level Date Summary of Changes

AA–R07DA–TE November 1996 Original release. This release
supports the StorageWorks
RAID Array 230/Plus RAID
Management Utility for
Windows NT.
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About This Guide

This guide describes how to install and load the StorageWorks RAID Array 230/Plus
RAID Management Utility for Windows NT and how to monitor and maintain your RAID
Array 230/Plus Subsystem.

Audience

This guide supports the user of a Windows NT system with a StorageWorks
RAID Array 230/Plus Subsystem. You should be familiar with StorageWorks
RAID terminology.

Related Documentation

RAID Array 230/Plus RAID Configuration Utility User’s Guide

RAID Array 230/Plus Release Notes

Microsoft Windows NT Operating System documentation.

Consult the Release Notes accompanying your software kit for the latest RAID
Array 200 Documentation titles and part numbers.

NOTE

Please read the Release Notes accompanying
your RAID Array 230/Plus software kit for
important information not found in this manual.

Organization

This guide contains the following sections:

Chapter 1:  Installing the Software — Describes how to load the Windows NT
driver and the configuration utilities on a system with an existing Windows NT
operating system and on one in which Windows NT is not yet installed.

Chapter 2:  Using the Utilities — Describes how to use the utilities to monitor
and maintain the StorageWorks RAID Array 230/Plus Subsystem.
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Typographic Conventions

This guide uses the following conventions:

Style Meaning

boldface monospace type To be input by the user

plain monospace type Screen text
italic type For emphasis, manual titles, utilities,

menus, screens, and filenames.

Glossary

Adapter:  This manual uses the terms adapter and controller interchangeably. A
controller is a specific kind of adapter.

Dead:  Condition of a logical drive when two or more associated physical
devices in a redundant logical drive are FAILed, or one or more associated
physical devices in a non-redundant logical drive have FAILed.

Degraded:  The resultant condition of logical drive(s) when one physical device
associated with the redundant logical drive is FAILed.

Disk array:  A set of disk devices and a specialized controller. The controller
keeps track of how the data is distributed across the disk devices.

Drive group:  A set of disk devices that are addressed as a single unit.

FAILed:  A disk drive is not accessible by the controller.

GB:  The size in gigabytes. A gigabyte equals 1 073 741 824 bytes.

Hot Spare:  A good disk drive that has been designated to be used when another
physical drive fails in a redundant logical drive.

Logical RAID drive:  A section of storage space presented to the operating
system as a single virtual device.

MB:  The size in megabytes. A megabyte equals 1 048 576 bytes.

Optimal:  The logical drive(s) and the associated physical device(s) are in good
condition.

Parity Check:  A logical drive is being tested for consistency .

RAID:  An acronym for a redundant array of independent (or inexpensive) disks.

RAID level:  A value that specifies the type of data management in an array of
drives.

Rebuild:  The process of transferring data to a replacement hard disk.
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Write-back caching:  A caching policy in which the controller acknowledges that
a write operation has completed successfully before the data is written to the
disks. If you choose this caching policy, you may increase the I/O performance
of your RAID subsystem, but if there is a power failure, you risk losing data in
cache that is not yet written to the disks. This risk can be reduced by use of the
battery backup option when write-back caching is employed.

Write Only:  Status of a physical device during the Rebuild process.

Write-through caching:  A caching policy in which the data is written to the
disks before the controller acknowledges that a write operation has completed
successfully. If you choose this caching policy and there is a power failure, you
minimize the chance of data loss.
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1
Installing the RAID Management Utility

for Windows NT
After installing and configuring the RAID Subsystem, you can now install the
StorageWorks RAID Array 230/Plus Management Utility for Windows NT. The software
consists of the Monitor utility and the RAID Management utility.

1.1 Load the Windows NT Driver

The procedure for loading the Windows NT driver software depends on whether
the Windows NT operating system is installed or is going to be installed at the
same time as the RAID Subsystem software. If you have not yet installed the
RA230/Plus controller, follow the instructions for doing so in the RAID Array
230/Plus Subsystem Installation Guide  before proceeding with the driver
installation.

1.1.1  If Windows NT Is Already Installed on Your Computer

This procedure copies the driver software to the system disk. Before you perform
this procedure:

• Log into the Windows NT system with Administrator privileges.

• Verify that you have at least 1 MB of free disk space.

Refer to your Microsoft Windows NT Operating System documentation for
instructions to add a SCSI adapter to your system. During this procedure you will
be asked for the type of adapter to be added. The RA230/Plus controller uses the
Mylex DAC960/SWXCR-EX device driver. Complete the SCSI device
installation procedure using the driver provided on your Windows NT
distribution media.

Shut down the system and reboot Windows NT. If the system fails to start
properly, see the Microsoft Windows NT Operating System documentation for
troubleshooting  information.

The driver is now installed and the controller is active.
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1.1.2  If Windows NT Is Not Already Installed on Your Computer

Follow the directions from Microsoft Windows NT Installation Guide to install
Windows NT onto your platform. The installation procedure will perform mass
storage device detection  and identify the presence of a RAID Array 200 series
controller as a Mylex DAC960/ SWXCR-EX device. Confirm this when
prompted and complete the installation Windows NT on your system.

After completing the installation of Windows NT, the driver is now installed and
the controller is active. Follow the on-line instru ctions to complete the
installation of the Windows NT operating system.

1.2 Install the RAID Array 230/Plus RAID Management Utilities

This procedure creates a StorageWorks program group and icons for the utilities
by installing the executable files to a user-specified directory. The monitor utility
is installed as a system service. This setup utility can also be used to remove the
RAID Array 230/Plus RAID Management Utilities.

1. Insert the RAID Array 230/Plus RAID Management Utility for Wi ndows NT
floppy diskette into your system’s floppy drive.

2. From the Program Manager’s File menu, choose Run.

3. Type a:\setup and follow the instructions to either install or remove the
RAID Management Utilities.

4. When the process is complete, the system displays the icons in the
StorageWorks program group.

5. To start the monitor service, reboot the operating system, or start the service
manually from the control panel.

1.3 Partition a Logical RAID Drive

Each logical RAID drive in the RAID Subsystem must be partitioned. Use the
Windows NT Disk Administrator to partition the logical RAID drives according
to your storage requirements. See the chapter on the Disk Administrator in
Microsoft’s Windows NT System Guide for more information on partitioning . The
following procedure partitions a logical RAID drive.

1. In the Administrator Tools window, click on the Disk Administrator icon to
display a graphic representation of the existing partitions. The free space
represents the disk space of the logical RAID drive.

2. Choose Create from the Partition menu.
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3. Specify the size of the new partition. The Disk Administrator assigns a letter
to identify the logical RAID drive. Repeat for each partition.

4. When you are finished partitioning, choose Commit Changes Now from the
Partition menu and proceed to format the partition as explained in the next
section.

1.4 Format the Partition

Format the logical RAID drive in the same way you format other drives. To
format from the Tools menu within the Disk Administrator, see the chapter on
the Disk Administrator in Microsoft’s Windows NT System Guide. The following
procedure formats a logical RAID drive from an MS-DOS window.

NOTE

Do not define a Windows NT bootable partition
larger than 2 GB. Refer to your Microsoft
Windows NT System Guide for additional
information on partition size for bootable
partitions.

1. Click on the MS-DOS Prompt icon.

2. Type format /fs:file_system x: where file_system is one of
the Windows NT formatting options and  x is the letter assigned to the logical
RAID drive.

3. Enter a label at the prompt.

4. Type Exit to return to Windows NT.

The Windows NT operating system can now use the RAID Subsystem.

1.5 Installing a Tape or CD-ROM Device

The RA230/Plus supports Tape and CD-ROM devices under the Windows NT
operating system. You can install any Tape or CD-ROM device that is listed in
the Release Notes.
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2
Using the Utilities

The RAID Array 230/Plus RAID Management Utility for Windows NT provides the
following utilities to maintain the RAID Subsystem: SWXCR Monitor shows the status of
the subsystem and the SWXCR Manager displays or changes the configuration of the
disk drives. Using information reported by the Monitor, use the Manager to take action.

2.1 Monitoring the Subsystem

The Monitor utility runs continuously to record the actions of the controllers. It
forwards actions recorded about logical drives and failed disk drives to the
Windows NT Event Viewer.

To view significant controller actions, use this procedure:

1. Invoke the Event Viewer in the Administrative Tools program group.

2. Select Application from the Log menu.

3. Look for entries with the label: swxcrsrv

NOTE

The state of the array may be monitored remotely
via the Event Viewer using the “Select Computer”
menu selection.

2.2 Managing the Subsystem

The utility displays the current configuration and status of the disk drives. Use
this utility to make the following changes:

• Rebuild a Failed disk drive.

• Fail a disk drive in order to replace it with another.

• Check the consistency of a logical drive.
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To invoke the utility, click on the Manager icon; another window opens with the
Management, Configuration, and Help menus available. The functions available
on the Management menu are listed in Table 2 –1. The functions avai lable on the
Configuration menu are listed in Table 2 –2.

Table 2–1  Functions of the Utility — Management Menu

Function Meaning

Select Adapter Specifies the controller. All information displayed by the other
functions refers to this controller.

Rebuild Rate Specifies the priority of a rebuild operation.

Rebuild Drive Reconstructs the data from a failed disk drive onto a new one.

Parity Check Checks the consistency of data in the disks of a logical drive with a
redundant level.

Fail Drive Changes the state from OPT (optimal) to FAIL.

Make Optimal Changes the state from FAIL to OPT.

Table 2–2  Functions of the Utility — Configuration Menu

Function Meaning

Select Adapter Specifies the controller. All information displayed by the other
functions refers to this controller.

Logical Drive Displays the status and errors of the logical drive.

Logical Drive Identifies the disk drives in a logical drive.
Mapping

Device Information Displays the current configuration, status, and errors of drives.

Make HotSpare Makes a failed disk drive a HotSpare.

If the subsystem has two controllers, use the Select Adapter function to specify
the controller with which you want to work.  If the subsystem has one controller,
you do not need to identify it.  Use the following procedure to specify the
controller or to find out how many are installed:

1. Click on the Select Adapter function on the Options menu. The Manager
utility displays a dialog box with buttons labeled for each controller.

2. Click on the button for the controller you want. All the information and
actions of the remaining Manager functions affect the disk drives of this
controller.

To exit from the utility, click on the window’s Close button.
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2.3 Finding Out About the Configuration

If you are investigating a problem with a disk drive, use Configuration menu. To
find out how a disk array has been configured, follow these steps:

1. Use the Logical Drive function to find out how many logical drives have
been defined.

2. Use the Logical Drive Mapping function to find out which physical disk
drives are in which logical drives.

3. Use the Device Information function to find out about a specific disk drive.

4. Use the Make HotSpare function if you want to make a failed drive a hot
spare.

2.3.1  About the Logical Drive

Use the Logical Drive function to display information about the collection of
disk drives. When you click on this function, the Manager utility displays a
dialog box with the information shown in Table 2 –3. You cannot change any of
these specifications.

Table 2–3  Specifications for a Logical Drive

Number RAID Level Write Policy Size Status

0 through 7 0, 1 WTH (Write-through) MBs Optimal

0+1, 5 WB (Write-back) Degraded

JBOD Dead

For an explanation of the terms used in the table, see the Glossary section of
About this Manual in this guide.

2.3.2  About Logical Drive Mapping

Use the Logical Drive Mapping function to display information about the drive
groups within each logical drive.  When you click on this function, the Manager
utility displays a dialog box that shows the specifications for each logical drive,
similar to Figure 2–1.
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Figure 2–1  Map of a Logical Drive

Logical Drive 0

RAID 1

Span 0  [Channel:Id]> 0:1  1:2
The display shows how the physical disk drives have been assigned to the logical
drives. The disks are identified by channel and position, using the form:  channel
ID::SCSI ID.

2.3.3  About the Drive Information

Use the Device Information function to display information about the way the
disk drives are operating.  When you click on this function, the utility displays the
graphic representation of the disk array shown in Figure 2 –2. Each box
represents a disk drive and the box label is the status of the disk drive: optimal,
failed, or spare. The utility identifies non-disk devices with TAP (for Tape), or
CD (for CD-ROM) in their boxes instead of a status.

Figure 2–2  Display of the Current Disk Array
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To find out more about a particular disk drive, click on its box. The uti lity
displays a catalog of the errors that have been logged for the disk drive, as
described in Table 2–4. The controller fails a disk drive with too many hard,
parity, or miscellaneous errors, but it does not act on soft errors. If the disk drive
is accumulating soft errors, you must replace the disk drive. After selecting OK,
the Device Selection menu is redisplayed.

NOTE

All counters are reset to zero on each power cycle
of the controller.

Table 2–4  Type of Errors

Errors Description Limits

Soft Condition or data errors Replace the disk drive when the rate of
errors increases or the count exceeds 100

Hard Hardware malfunction Controller fails the drive at about 2 - 4
errors

Parity SCSI bus error during transfer

Miscellaneous Time out, for example Controller fails the drive at about 40 errors

Model Type Identifies the type of drive



RAID Array 230/Plus Subsystem RAID Management Utility for Windows NT

2–6 AA–R07DA–TE

2.3.4  About Making a Hot Spare

NOTE

The Hot Spare must have a storage capacity
equal to or greater than any drive it would
potentially replace.

Use the Make HotSpare function to designate a drive as one to be used for an
automatic rebuild. The drive must have a FAIL status and not be part of a drive
group. When you click on this function, the utility displays a graphic
representation of the disk array similar to that shown in Figure 2 –2. Any drive
that is failed can be selected to make a hot spare.

2.4 Maintaining the Subsystem

Your maintenance goal is to keep the logical drives in the Optimal state. This
means that all disk drives assigned to the logical drive are available. If a disk
drive fails, what happens next depends on the following conditions:

• RAID level

• Whether or not a hot spare disk drive is available

• Whether or not another disk drive fails before you restore the logical drive to
the Optimal state

• Logical drive consistency

Use the chart in Figure 2–3 to determine your actions. To minimize the chance
of data loss, replace a FAILed disk drive as soon as possible.
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Figure 2–3  Actions for Maintaining the Subsystem

If a disk drive fails on a RAID 0 or JBOD subsystem:

Status of logical drive changes from Optimal to Dead.

You replace the failed disk drive.

You restore the data from a backup source.

If a disk drive fails on a RAID 1, 0+1, or 5 subsystem:

Status of logical drive changes from Optimal to Degraded

Hot Spare available: No Hot Spare available:

Controller rebuilds data on the hot
spare.

You replace the disk drive.

Status of logical drive returns to
Optimal.

Controller rebuilds data on the
new disk drive automatically if
Fault Management is enabled,
otherwise you will have to use
the Rebuild option.

You replace the failed disk drive. If the
controller’s StorageWorks Fault
Management has been enabled, the
new disk becomes the hot spare
automatically. If StorageWorks Fault
Management is not enabled, you define
the new disk as the hot spare using the
utility.

Status of logical drive returns
to Optimal.
You may want to consider
designating a hot spare.

If a second disk drive fails in the same logical drive:

Status of logical drive changes from Degraded to Dead.

You replace the failed disk drives.

Initialize the logical drive using the utility

Status of logical drive changes from Dead to Optimal

Restore data from a backup source
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2.4.1  Rebuilding a Disk Drive

If you have a nonredundant configuration (RAID 0) and a disk drive fails, all of
the data is lost. If the disk drives are in a redundant configuration (RAID 1,
RAID 0+1, and RAID 5) and a disk drive fails, you can rebuild the disk drive by
reconstructing the data. A rebuild of a disk drive occurs in the following ways:

• Hot Spare:  If one of the disk drives is defined as a hot spare, the co ntroller
rebuilds the data onto the hot spare automatically.

• Hot Swap:  If the controller’s Fault Management option has been enabled and
you replace a disk drive while the subsystem is operating, the controller
rebuilds the data onto the new disk automatically.

• Manual Rebuild:  If you failed a disk drive or if an automatic rebuild is in
progress, you can start the rebuild process.

To perform a manual rebuild, use the following procedure.

Remove the failed disk drive and put in a new disk drive. The status of the new
disk drive remains as FAIL.

1. Click on the Rebuild Drive function on the Options menu. The controller starts
the new disk drive.

2. Select the disk drive from the graphic display. The controller rebuilds the data
on the new disk drive. The rebuild status bar gradually fills as the process
completes. During the process, the status is displayed as three dots    (. . .)

3. When the bar displays 100%, click on the OK button in the confirmation box.
The status is now OPT.

2.4.2  Controlling the Rebuilding Rate

The rebuilding process runs at the priority you designate. Use the Rebuild Rate
function to specify the priority of the rebuild process, whether performed
automatically or manually.

A rate of 50 is the fastest and causes the rebuild process to run at equal priority
with other disk operations. The rate of 0 is the slowest, and causes the process to
run only when there is no other disk activity. As a guideline, allow 20 minutes to
rebuild 1 GB of data when the rebuild rate is set at 50 with minimal disk activity.
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1. Click on the Rebuild Rate option. The dialog box displays a slider scale that
runs from 0 to 50.

2. Click on the bar or the arrow buttons to specify a rate. Do not attempt to drag
the slider. The rate is updated.

3. Click on OK. The new rate is in effect.

2.4.3  Failing a Disk Drive

Drives log different types of errors. For most types of errors, when a drive logs
many of them, the controller will automatically fail it to stop activity to that
drive. The controller will not fail a drive logging many soft errors. Therefore, if a
drive logs many soft errors, to stop activity to it, you need to manually fail that
drive. To fail a disk drive, follow these steps:

NOTE

When you click on a disk drive, the utility fails the
drive immediately, without a confirmation step. If
you click on the wrong disk drive, use the Rebuild
Drive to recover the data.

When a disk drive is manually failed, it is
expected that the user will replace the disk drive.
Therefore, a Hot Spare will not be used to perform
a Rebuild of the logical drive.

1. Select the Fail Drive function. The utility displays a graphic similar to
Figure 2-2.

2. Click on the disk drive. The status changes to FAIL. The status of the logical
drive is now Degraded.
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2.4.4  Checking the Logical Drive Consistency

Use the Parity Check function to check a logical drive for the consistency of the
parity information. Run this utility after a power failure or system crash to verify
the integrity of parity information on logical drives. This utility is only available
for redundant RAID levels (RAID 1, RAID 0 + 1, and RAID 5).

The Parity Check function reads the data from the logical drive and co mputes the
expected parity information for each series of blocks. It compares the computed
parity to the stored parity information on the drives and can rebuild the data if
needed. If you choose not to fix the inconsistent parity information, your data
may not be reconstructed correctly when you rebuild a disk drive.

To perform a parity check, use the following procedure:

1. Click on the Parity Check function. The Manager utility displays a dialog
box similar to Figure 2–4.

2. To change the priority of the operation, click on the Parity Check Rate bar or
its arrows.

3. Click on the logical drive.

4. Click on OK. The utility asks if you want to rebuild the data if the parity
check is inconsistent.

5. Click on Yes. The utility checks the data and reports its progress as a
percent. You can interrupt the check at any time by clicking on the Cancel
button. When the checking process is completed, the utility displays a
confirmation box.

6. Select Yes to confirm.

Figure 2–4  Dialog Box for the Parity Check
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